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Chapter 1. Contacting IBM Unica technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM® Unica technical support. Use the information in this section to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
Unica administrator for information.

Information you should gather

Before you contact IBM Unica technical support, you should gather the following
information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System Information" below.

System information

When you call IBM Unica technical support, you might be asked to provide
information about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
Unica applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by
viewing the version.txt file located under each application’s installation directory.

Contact information for IBM Unica technical support

For ways to contact IBM Unica technical support, see the IBM Unica Product
Technical Support website: (http://www.unica.com/about/product-technical-
support.htm).
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Chapter 2. System requirements and compatibility

IBM Unica Marketing Operations operates as part of the IBM Unica Marketing
suite of products.

Marketing Operations version 8.5.0 requires IBM Unica Marketing Platform 8.5.0.

You can upgrade to Marketing Operations 8.5.0 from Affinium Plan 7.5.1 or later. If
you are using an earlier version, you must upgrade to Affinium Plan 7.5.1 as an
interim step. For instructions, see the IBM Unica Marketing Operations Installation
Guide.

For reporting, Marketing Operations 8.5.0 uses the 8.5.0 version of the Marketing
Operations and the Marketing Operations/Campaign reports packages.

Where to find complete system requirement and compatibility
information

For a list of IBM product versions compatible with this product, refer to the IBM
Unica Compatibility Matrix and any other product compatibility documents posted
under Documentation on the IBM Unica Customer Central web site
(https://customers.unica.com).

For a list of third-party requirements for this product, refer to the Recommended
Software Environments and Minimum System Requirements posted for Marketing
Operations version 8.5.0 on the IBM Unica Customer Central web site
(https://customers.unica.com).

Key third-party software support changes in version 8.5.0

IBM Unica Marketing Operations version 8.5.0 has added support for the following
new versions of third-party software.

Operating Systems

v AIX 7.1
v RHEL v5 64 bit

Browsers

v Internet Explorer 8

New features and changes in version 8.5.0
IBM Unica Marketing Operations 8.5.0 contains enhancements to language support,
acessiblity of the configuration properties, financial approvals, campaign
integration, task workflow, and working with metrics.

IBM Unica product language support
With release 8.5.0, IBM Unica products support the following languages:
v Brazilian Portuguese
v English
v French
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v German
v Italian
v Japanese
v Korean
v Simplified Chinese — including compliance with GB18030 requirements
v Spanish

See the IBM Unica Marketing Platform Administrator's Guide for information on
setting locale preferences.

Configuration Properties
The IBM Unica Marketing Operations configuration properties are now under
Settings > Configuration > Marketing Operations in the IBM Unica Marketing
Platform instead of the planconfig.xml file. See the IBM Unica Marketing Platform
Administrator's Guide for more details.

Financial approvals
Rule-driven budget approval

Marketing administrators can define rules in program and project templates on the
Budget Approval Rules tab. If budget line items meet the criteria of the rule, an
approval process is triggered. If budget line items do not meet rule criteria, they
are automatically approved. Budget line items are not rolled up to parent programs
and plans until they are approved.

In addition to custom attributes, the following standard attributes can be used to
create rules.
v Expenditure date
v Source account
v Cost category
v Committed amount
v Forecast amount
v Vendor name

Option to revert rather than request budget approval

After adding new budget line items, users can finalize them, which may trigger an
approval process depending on rules defined in the object template. Alternatively,
users can revert back to the previous saved version of the budget line items, which
will not trigger any approvals.

Rule-driven invoice approval

Marketing administrators can define rules on the Budget Approval Rules tab of the
invoice template based on invoice or line item attributes. If invoice line items meet
the criteria of the rule, an approval process is triggered. If the line items do not
meet rule criteria, they are automatically approved. Invoice line items can not be
marked "payable" or charge to accounts until all line items on the invoice are
approved.

In addition to invoice attributes, which may be custom to your organization, the
following line item attributes can be used to create rules.
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v Invoice Amount
v Source account
v Cost category
v Cost per unit
v Quantity
v Cost

Option to revert rather than request invoice approval

After adding new invoice line items, users can finalize them, which may trigger an
approval process depending on rules defined in the invoice template. Alternatively,
users can revert back to the previous saved version of the line items, which will
not trigger any approvals.

Line-item level tracking and re-approvals

Each line item that needs approval, or reapproval after changes have been made,
appears on the approver's list of "items to approve."

An approval status icon for each line item is also shown on the object's Budget
Summary tab. Clicking on the icon opens the approval.

IBM Unica Campaign-Marketing Operations offer integration
The following list summarizes the offer integration features for IBM Unica
Campaign and IBM Unica Marketing Operations.

New "offer" marketing object type

Offers are available in Marketing Operations 8.5.0 as a system-defined marketing
object. Users cannot define offers manually.

Offer states

Offers have the following states.
v Draft: Whenever the new offer instance is created, the state of the offer is Draft.
v Published: The state Published pushes the offer instance to Campaign. The first

publish creates the offer in Campaign; subsequent publishing updates the offer
instance in Campaign.

v Redraft: Once the offer is Published, it cannot be edited. To edit a published offer,
the user can redraft the offer, which changes it to the Draft state. User can then
edit the offer and publish changes.

v Retire: Only Published offers can be Retired. Once the offer is Retired, it is not
available for the future use and cannot be edited or changed to any other state.

Create new offer instances from offer templates

Offer instances can be created in Marketing Operations from templates published
to Campaign. The offer instance also has the attributes Campaign Security Policy
and Campaign Offer code.
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Offer approvals

Marketing Operations provides a check box for offer approval. Offers can only be
published to Campaign if they are approved.

Static and dynamic attributes shared with Campaign

Marketing Operations has pre-defined offer standard attributes populated in case
offer integration with Campaign is enabled. A new category for custom offer
attribute is available in the Shared Attributes, which can be edited from Marketing
Operations.

Offer codes automatically generated

In Marketing Operations, the offer code is generated by the Default code generator.
Users cannot modify the offer code generator. In the wizard mode of offer creation,
the check box “Auto-generate on save” creates the offer code automatically. If the
check box is selected, the offer code is generated from Campaign. If the check box
is not selected, validation is made for the valid offer code.

Ability to use Marketing Operations offer management or stay
with current solution

Offer integration is a separate option from campaign integration. When campaign
integration is enabled, offer integration may also be enabled.

Task Workflow
IBM Unica Marketing Operations 8.5.0 contains a task pane to streamline
workflow.

View and edit tabs on the task pane

Clicking on a task in the My Tasks page opens the task pane on the right and the
task's parent object on the left. The task pane provides shortcuts to many
Marketing Operations functionalities.
v Edit the project's tabs
v Add Attachments
v Read and post messages
v Manage team members and reviewers
v Find and replace task owners and reviewers
v Edit the workflow
v Edit budget allocations and line items
v Edit Tracking

Create objects on the task pane

Users can create sub-projects, project requests or linked objects (Existing projects,
requests) as part of working on their task using links on the task pane.

Create a series of linked objects on the task pane

Using the Save and Duplicate feature, users can create a series of similar linked
objects.
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Work with tasks in context

The task pane provides context for tasks by showing the next task in the workflow
(that the user has permission to see) on the bottom of the task pane. If the user
does not have permission to edit it, the task is in view mode. Users can also record
effort time and write hand-off comments.

Move efficiently through tasks and approvals in the queue

The following tools allow you to move through multiple tasks and approvals
directly on the task pane.
v Skip the task by clicking Skip

v Save the task to work on later by clicking Save for Later

v Mark the task complete by clicking Finish

Metrics editor
IBM Unica Marketing Operations 8.5.0 no longer uses the external metrics editor.
Users can now create metrics, metrics dimensions, and metrics templates on the
template creation page.

If you are upgrading to Marketing Operations 8.5.0, existing metrics templates are
marked "legacy" so that existing plans, programs, and projects can continue to use
them.

IBM WebSphere Application Server V7.0 requires fixpack
7.0.0.17 or higher

If you plan to use the IBM WebSphere® Application Server V7.0 to deploy any IBM
Unica Marketing products, you must apply Fix Pack 17 (also referred to as Version
7.0.0.17) or higher to address a security issue. This applies to all WebSphere
Application Server 7.0 packages, including the version that is bundled with some
IBM Unica Marketing products.

You can obtain Fix Pack 17 or higher here:

http://www-01.ibm.com/support/docview.wss?rs=180&uid=swg27013594.

Note that on that page, you must select the correct Fix Pack before you download.

For additional information about supported WebSphere versions for deploying IBM
Unica Marketing products, see the Recommended Software Environments and
Minimum System Requirements document for each product.

Fixed defects
The following defects have been fixed in IBM Unica Marketing Operations version
8.5.0.

Issue ID Description

DEF048703, INC47266 Issues while installing Marketing Operations on Sun Solaris Server
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Issue ID Description

DEF050446 If a form with a single-select object reference attribute with the "auto-create" option was
exported, then the auto-create option was not retained when importing the form into
another Marketing Operations environment. This is fixed. Now a new xml attribute
"<autocreate>," exported with the form, retains the auto-create option for the single-select
reference attribute when the form is imported into another Marketing Operations
environment.

DEF054274, INC54853 Upgrade may fail if an erroneous configuration property was manually removed

DEF057147 Importing a form archive (zip) file into Marketing Operations, caused an error if the zip
file being imported contained multiple forms (valid xml files). This occurred because
importing multiple forms simultaneously was not supported which resulted in the
stack-overflow error.

This is now fixed. Now a zip file containing multiple forms (valid xml files) can be
imported simultaneously without any error.

Known limitations

This table contains known limitations in IBM Unica Marketing Operations version
8.5.0.

Issue Issue ID Description

When offer
integration is enabled,
the Relevant Products
field is read-only
when an offer is
opened in Campaign.

ENH11503 Relevant Products is a default (required) attribute in offer templates in IBM
Unica Campaign. When you create or edit an offer in Campaign, you have
the option of populating the field, either by importing product IDs or
constructing a query. However, with offer integration enabled, the field is
not editable when the offer is opened in Campaign, and the field is not
visible in Marketing Operations. The workaround is to create a multi-select
custom campaign attribute and place it on an offer in Marketing
Operations.

Unable to add forms
or templates with
non-English
characters in the
"form name," "form
attribute name," or
"table name" fields

DEF057100 Form and template fields with non-English characters cannot be saved.

The task pane allows
users to edit the
Summary tab even if
the project is
cancelled or
completed

DEF057121 If the task pane is opened in the right panel and the project is cancelled or
completed simultaneously in the Summary tab on the left, the project forms
can still be edited in the task pane, even though it is no longer active.

Only ASCII names
are allowed in
Template ID

DEF057394 Template_id is an internal name for the template, which accepts only
simple alphanumeric English characters, excluding spaces and special
characters. Users cannot enter localized (non ASCII) inputs for the
Workflow Template Name, Icon Name, Rule Name, or data mapping file
name.
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Issue Issue ID Description

Primary key violation
when a legacy metrics
template is mapped
to new template

DEF057563 In Marketing Operations version 8.5.0, the external metrics editor was
moved into the application. Metrics templates made in version 8.5.0 contain
strict types, corresponding to plans, programs, or projects.Although
Marketing Operations keeps legacy metrics templates for use with plan,
program, or project templates created prior to version 8.5.0, these legacy
metrics templates cannot be used in new object templates because they lack
type information. When creating new plan, program, or project templates,
users need to use a metrics templates with the same type. If users need to
use a legacy metrics template in a new object template, they must re-create
it using Marketing Operations's new internal metrics configuration feature.

Default dates on the
grid do not always
localize correctly

DEF057605,
DEF040170

Grid's date-picker widget is not completely localized for non-English
locales, so the default value for a grid date attribute is not always
populated for some non-English locales (such as Japanese).

Users can not add
Marketing objects in
other languages
except English

DEF057079 Marketing Operations does not allow multibyte characters in the marketing
object type name.

A reviewer who has
not yet responded
cannot continue an
"On Hold" Approval
from right task pane

DEF057650 If a reviewer has not responded to an Approval in the "On Hold" state,
then he or she cannot continue that approval from Task Right Pane. In this
case, the 'Approve', 'Approve w/changes' and 'Deny' buttons are displayed
for the Approval on right pane, but 'continue' and 'cancel' buttons doesn’t
get displayed in this case. By contrast, an approver who has already
responded to the approval can continue it from right pane.

This scenario occurs because the buttons on the right pane are driven by
the role of the user: Approver or Approval owner. If the approver and the
owner are the same user, approver actions take preference.

Formulas for
computing metrics
need to be written in
English

DEF057660 When adding metrics to metrics templates, the user can specify them as
Planned or Rollup. If the user enters a formula in the 'Computed by
Formula' field, the formula must be in English. If the user enters translated
string for "rollup," then Marketing Operations throws an error.

Metrics formulas are
not validated

DEF057726 When an invalid formula is specified while creating metrics, Marketing
Operations throws an exception while finalizing the values entered in the
Tracking tab of an object instance that uses the metric. Please see the
product documentation for information about valid operators and
operands.

Offers are not
available in the
'Marketing Object
Type' dropdown
when adding a
SSOR/MSOR
attribute

DEF059340 Marketing Operations version 8.5 has a default marketing object 'Offers'
(uap_sys_default_offer_comp_type) for integration with Campaign's offer
management. If a single-select object reference attribute referring to the
marketing object type "Offers" is created using the auto-create option, it
causes problems since some essential fields (for example: Campaign offer
code) are not generated with the auto-created offers. To avoid these
subsequent problems, the SSOR and MSOR attributes are not allowed to
refer to Offers. Offers are not made available in the 'Marketing Object Type'
dropdown while adding a SSOR/MSOR attribute.

Limitations in
importing offer
templates

DEF059793 The offer template won't be allowed to import in following cases.

v If an offer template with same id already exists, then a new offer
template will not be allowed to import.

v If an offer template was published and deleted, then a new offer
template with same id will not be allowed to import.

v If any form with same name is used in an offer template then the offer
template will not be allowed to import.
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Known issues

This table contains known issues in IBM Unica Marketing Operations version 8.5.0.

Issue Issue ID Description

Subgroup
authentication

DEF022909, INC20721 Creating an Admin subgroup in the IBM Unica Marketing Platform
does not automatically add the users in the subgroup as Marketing
Operations administrators. You must specifically grant the admin
access to the subgroup.

Legacy metrics
mapped to response
history retain deleted
values

DEF046008, INC55503 If the response history table is cleared in Campaign, any Marketing
Operations metrics that are mapped to the response history table
retain the deleted values.

Budget Reports do not
display correctly when
the granularity is
weekly or monthly

DEF054904 This problem occurs to the database design changes done for the
Financial Planning module in the Marketing Operations 8.2.0
release.

Integrated
Campaign-Marketing
OperationsReports do
not display correctly
when the granularity
is weekly or monthly

DEF055000 This problem occurs to the database design changes done for the
Financial Planning module in the Marketing Operations 8.2.0
release. To manually (report upgrade cases) make changes to the
Campaign Offer Financial Comparison

1. Open the report in Report Studio.

2. Edit the Report Query.

3. Edit the Budget Total query item definition to pull from
Campaign Project by Offer > Campaign Project > Budget Total

4. Change aggregation to be Total/None.

5. Edit the Committed Total query item (in Report query) to pull
from Campaign Project by Offer > Campaign Project >
Committed Total.

6. Change aggregation to be Total/None.

Advanced Search
documentation
incomplete

DEF058801 The templates dropdown only appears on the Advanced Search
screen for marketing objects when there are multiple templates
available for that object. There will be more information about
using Advanced Search in a future version of the IBM Unica
Marketing Operations User's Guide.

Authentication set up
for cognos reports
documentation
incomplete

DEF058526 To set up the authentication mode as 'authenticated per user,'
Cognos should have "AAA\lib" directory available at following
path: %COGNOS_HOME%\webapps\p2pd\WEB-INF\AAA\lib.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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